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New and Changed Information

New and changed information for the most recent releases of the Process Automation Guide for 
Automation for SAP BOBJ Accelerator is as follows:

 • Latest Release

 • Previous Releases

Latest Release

Previous Releases

Table 1 December 2013—Process Automation Guide for Automation for SAP BOBJ 

Accelerator 3.0 Changes

Feature Location

Revised Text Part Number (-01 to -02). Front cover, footers

Updated Trademark and Copyright date Inside cover page

Rebranded the Product Name All chapters

Table 2 April 2012—Cisco TEO Process Automation Guide for Automation for SAP BOBJ 

Accelerator 2.3 Changes

Feature Location

Revised Text Part Number (-01 to -02). Front cover, footers

Updated Trademark and Copyright date Inside cover page

Renamed appendix based on automation pack 
name

Appendix A, “Core Automation for SAP BW, 
BOBJ and In-Memory Computing Automation 
Pack Content”
vii
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New and Changed Information
  
Updated “Defining an Activity” section Appendix A, “Core Automation for SAP BW, 
BOBJ and In-Memory Computing Automation 
Pack Content”

Added new appendix Appendix B, “Common Activities Automation 
Pack Content”

Table 2 April 2012—Cisco TEO Process Automation Guide for Automation for SAP BOBJ 

Accelerator 2.3 Changes

Feature Location
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Preface

The SAP automation pack files are a collection of Cisco Process Orchestrator (CPO) processes 
(workflows) authored by subject matter experts that work out-of-the-box to automate best practices for 
a particular technology. The automation pack files also include configuration objects that are used in the 
processes, such as variables, categories, target groups and knowledge base articles.

The SAP Automation Pack for Automation for SAP BOBJ Accelerator contains the content used to 
automate monitoring Business Objects XI Data Services content. This guide is intended to provide 
information on importing and using the Automation for SAP BOBJ Accelerator automation pack in 
Cisco Process Orchestrator.

Organization
This guide includes the following sections:

Chapter 1 Importing Automation Packs Provides instructions for installing the automation 
packs during or after the initial installation of 
Cisco Process Orchestrator. 

Chapter 2 Understanding Automation Pack 
Objects

Provides information on the objects included in the 
Automation for SAP BOBJ Accelerator 
automation pack.

Chapter 3 Getting Started Using the 
Automation Pack

Provides information on configuring the objects in 
Cisco Process Orchestrator that are referenced by 
or included in the automation pack, such as 
runtime users, targets, task rules, target properties, 
and global variables.

Chapter 4 Managing Automation for SAP 
BOBJ Accelerator Processes

Provides information on using and managing the 
Automation for SAP BOBJ Accelerator processes.

Appendix A Core Automation for SAP BW, 
BOBJ and In-Memory Computing 
Automation Pack Content

Provides information on the objects included in the 
Core Automation for SAP BW, BOBJ and 
In-Memory Computing automation pack.

Appendix B Understanding the Common 
Activities Content

Provides information on the objects included in the 
Common Activities.
ix
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Preface
  
Conventions
This guide uses the following conventions: 

Note Means reader take note.

Tip Means the following information will help you solve a problem. 

Caution Means reader be careful. In this situation, you might perform an action that could result in equipment 
damage or loss of data.

Timesaver Means the described action saves time. You can save time by performing the action described in 
the paragraph. 

Warning Means reader be warned. In this situation, you might perform an action that could result in 
bodily injury.

Convention Indication

bold font Commands and keywords and user-entered text appear in bold font.

italic font Document titles, new or emphasized terms, and arguments for which you supply 
values are in italic font.

[   ] Elements in square brackets are optional.

{x | y | z } Required alternative keywords are grouped in braces and separated by 
vertical bars.

[ x | y | z ] Optional alternative keywords are grouped in brackets and separated by 
vertical bars.

string A nonquoted set of characters. Do not use quotation marks around the string or 
the string will include the quotation marks.

courier font Terminal sessions and information the system displays appear in courier font.

<   > Nonprinting characters such as passwords are in angle brackets.

[   ] Default responses to system prompts are in square brackets.

!, # An exclamation point (!) or a pound sign (#) at the beginning of a line of code 
indicates a comment line.
x
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Preface
Product Documentation

Documentation Formats
Documentation is provided in the following electronic formats:

 • Adobe® Acrobat® PDF files

 • Online help

You must have Adobe® Reader® installed to read the PDF files. Adobe Reader installation programs for 
common operating systems are available for free download from the Adobe Web site at www.adobe.com.

Guides and Release Notes
You can download the Cisco Process Orchestrator product documentation from Cisco.com. Release 
Notes can be found on Cisco.com and the product CD.

Online Help
Online help is available and can be accessed using the following methods:

 • Click the Help button on any dialog in the application to open the help topic in a pane to the right 
of the dialog.

 • In the Process Orchestrator console:

 – Click the Help Pane  tool on the toolbar to open the help topic in a pane to the right of the 
console results pane.

 – Click Help on the menu bar.

Open Source License Acknowledgements
Licenses and notices for open source software used in Cisco Process Orchestrator can be found in the 
Open Source License Acknowledgements found on Cisco.com. If you have any questions about the open 
source contained in this product, please email external-opensource-requests@cisco.com.

Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, submitting a service request, and gathering additional 
information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and 
revised Cisco technical documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to the What’s New in Cisco Product Documentation as a RSS feed and set content to be delivered 
directly to your desktop using a reader application. The RSS feeds are a free service and Cisco currently 
supports RSS Version 2.0.
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C H A P T E R 1

Importing Automation Packs

The Cisco Process Orchestrator Installation Guide provides instructions for installing Cisco Process 
Orchestrator (CPO) and the core components. During the initial installation of Cisco Process 
Orchestrator, you can choose to import the automation packs, or import them later from within the 
Console. 

The SAP Automation Pack for Automation for SAP BOBJ Accelerator has a dependency on other 
automation packs so these automation packs must be installed prior to installing the Automation for SAP 
BOBJ Accelerator automation pack.

This chapter guides you through importing the automation packs. It contains the following sections:

 • Accessing the Automation Pack Import Wizard, page 1-2

 • Importing the Core Automation for SAP BW, BOBJ and In-Memory Computing.tap, page 1-4

 • Importing the Common Activities.tap, page 1-5

 • Importing the Automation for SAP BOBJ Accelerator.tap, page 1-6

 • Installing TREX Script Files, page 1-6

Note It is recommended that you review the system requirements and prerequisites before importing 
automation packs. See the Cisco Process Orchestrator Installation Guide.
1-1
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Chapter 1      Importing Automation Packs
  Accessing the Automation Pack Import Wizard
Accessing the Automation Pack Import Wizard
You use the Automation Pack Import Wizard to import the automation packs (tap files). You can either 
open the wizard immediately after installing Cisco Process Orchestrator or from within the Console.

Opening the Import Wizard After Running Setup Wizard

Step 1 After running the Setup wizard to install the product, ensure that the Launch automation pack import 
wizard now check box is checked before closing the wizard.

The Select Automation Packs dialog box displays the available automation packs. All automation packs 
are checked by default.

Step 2 Ensure that the following check boxes are checked and then click OK to launch the Automation Pack 
Import Wizard:

 • Assessment for SAP BWA

 • Automation for SAP BW and BWA

 • Common Activities (dependency)

 • Core Automation for SAP BW, BOBJ and In-Memory Computing (dependency)

 • Automation for SAP BOBJ Accelerator 

Note See the Cisco Process Orchestrator Installation Guide for instructions on importing and configuring the 
Core components for the product.

Proceed to Importing the Core Automation for SAP BW, BOBJ and In-Memory Computing.tap, 
page 1-4.
1-2
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Chapter 1      Importing Automation Packs
  Accessing the Automation Pack Import Wizard
Opening the Import Wizard in Console
You can open the Automation Pack Import Wizard from within the Console after installing the product. 
When importing automation packs from within the Console, you must re-open the Automation Pack 
Import Wizard for each automation pack that you are importing. 

Because the Automation for SAP BOBJ Accelerator automation pack has a dependency on the Core 
Automation for SAP BW, BOBJ and In-Memory Computing automation pack, you must import this 
automation pack first.

Step 1 In the Administration workspace on the Console, click Automation Packs in the navigation pane.

Step 2 Use one of the following methods to open the Automation Pack Import Wizard:

 • In the navigation pane, right-click Automation Packs and choose Import.

 • On the Menu bar, choose Actions > Import.

Step 3 On the Windows Open dialog box, select the Core Automation for SAP BW, BOBJ and In-Memory 
Computing.tap file and click Open to open the Automation Pack Import Wizard. 

Proceed to Importing the Core Automation for SAP BW, BOBJ and In-Memory Computing.tap, 
page 1-4.
1-3
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Chapter 1      Importing Automation Packs
  Importing the Core Automation for SAP BW, BOBJ and In-Memory Computing.tap
Importing the Core Automation for SAP BW, BOBJ and 
In-Memory Computing.tap

The Automation Pack Import Wizard guides you through importing the automation packs. If you opened 
the Automation Pack Import Wizard from the Setup Completed panel, the wizard will guide you through 
importing each automation pack. 

Step 1 On the Automation Pack Import Wizard Welcome panel, click Next.

Note If you do not want to display the Welcome panel the next time the wizard is opened, check the Do not 
show this page next time check box.

Step 2 On the General Information panel, review the information about the automation pack.

Step 3 If you want to disable all the processes that are imported with the automation pack, check the Disable 
all imported processes check box.

Note If you disable the imported processes, you will need to manually enable the processes in the 
Console before they can execute.

Step 4 Click Next to continue.

The Data Extraction panel is used to specify the destination where the BWA Script files will be extracted. 
The script files are used in the direct TREX monitoring processes and must be copied to the TREX 
server.

Note If you uncheck the BWA Scripts check box, the files will not be extracted.

Step 5 Accept the default location or click the Browse  tool to specify a different location to extract the files 
and then click Next.

The Review Prerequisites panel displays the prerequisites for the automation pack being imported. The 
green check mark indicates that the prerequisite was found on the computer. 

The red X indicates that the prerequisite was not found on the computer. When this occurs, the import 
process is stopped and cannot continue until all prerequisites have been met. 

If all prerequisites are passed, the wizard automatically continues to the next panel.

Note If you opened the Automation Pack Import Wizard from the Setup Completed panel, the wizard 
displays the General Information panel for the next automation pack. 

Step 6 CAfter the objects have been imported, review the information on the Completing the Automation Pack 
Import Wizard panel to verify that it is correct and then click Close to exit the wizard.
1-4
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Chapter 1      Importing Automation Packs
  Importing the Common Activities.tap
Importing the Common Activities.tap
If you are importing the automation packs from within the Console, you must re-open the Automation 
Pack Import Wizard to import the Common Activities automation pack. 

Step 1 Use one of the following methods to open the Import Automation Pack Wizard:

 • In the navigation pane, right-click Automation Packs and choose Import.

 • On the Menu bar, choose Actions > Import.

Step 2 On the Windows Open dialog box, select the Common Activities.tap file and click Open to launch the 
Automation Pack Import Wizard.

Step 3 On the Welcome panel, click Next.

Step 4 On the General Information panel, review the information about the automation pack.

Step 5 If you want to disable all the processes that are imported with the automation pack, check the Disable 
all imported processes check box.

Note If you disable the imported processes, you will need to manually enable the processes in the 
Console before they can execute.

Step 6 Click Next to continue.

If all prerequisites are passed, the wizard automatically continues to the next panel.

Step 7 After the objects have been imported, review the information on the Completing the Automation Pack 
Import Wizard panel to verify that it is correct and then click Close to exit the wizard.
1-5
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  Importing the Automation for SAP BOBJ Accelerator.tap
Importing the Automation for SAP BOBJ Accelerator.tap
If you are importing the automation packs from within the Console, you must re-open the Automation 
Pack Import Wizard to import the Automation for SAP BOBJ Accelerator automation pack. 

Step 1 Use one of the following methods to open the Import Automation Pack Wizard:

 • In the navigation pane, right-click Automation Packs and choose Import.

 • On the Menu bar, choose Actions > Import.

Step 2 On the Windows Open dialog box, select the Automation for SAP BOBJ Accelerator.tap file and click 
Open to launch the Automation Pack Import Wizard.

Step 3 On the Welcome panel, click Next.

Step 4 On the General Information panel, review the information about the automation pack.

Step 5 If you want to disable all the processes that are imported with the automation pack, check the Disable 
all imported processes check box.

Note If you disable all the imported processes, you will need to manually enable the processes in the 
Console before they can execute.

Step 6 Click Next to continue.

If all prerequisites are passed, the wizard automatically continues to the next panel.

Step 7 After the objects have been imported, review the information on the Completing the Automation Pack 
Import Wizard panel to verify that it is correct and then click Close to exit the wizard.

Installing TREX Script Files
After you have completed importing the automation packs, you must install the script files to the TREX 
server. These script files are used in the direct TREX monitoring and corrective actions processes.

Note SAP BWA TREX Scripting is supported only on SAP BWA v7.20, Release 8 or later.

The script files are imported to the following location on the Process Orchestrator server by default:

Microsoft Windows Server 2003:

C:\Documents and Settings\local_user\My Documents\Cisco\Cisco Process Orchestrator\Extracted 
Data\BWA Scripts

Microsoft Windows Server 2008:

C:\Users\local_user\Documents\Cisco\Cisco Process Orchestrator\Extracted Data\BWA Scripts

Copy the BWA Scripts folder to the BWA host filesystem and run the install.sh command from the Bash 
shell to install the script files. 
1-6
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  Installing TREX Script Files
Note Both the install.sh and cisco_teo_python.tar files need to be copied to the server prior to running the 
install.sh command.

The script files are copied to the $DIR_INSTANCE\exe\python_support directory.
1-7
Process Automation Guide for Automation for SAP BOBJ Accelerator

OL-30852-01



Chapter 1      Importing Automation Packs
  Installing TREX Script Files
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C H A P T E R 2

Understanding Automation Pack Objects

The Automation for SAP BOBJ Accelerator automation packs contain the content used to automate 
monitoring SAP BWA and Business Objects XI Data Services content. This chapter provides 
information on the objects included in the Automation for SAP BOBJ Accelerator automation pack. It 
contains the following sections:

 • Accessing Automation Pack Properties, page 2-1

 • Viewing Automation Pack Content and Dependencies, page 2-3

Accessing Automation Pack Properties
You can access the automation pack properties from the Administration—Automation Packs view in the 
console. The automation pack properties dialog box displays general information about the content 
provided by the automation pack, version number, publish date, the provided objects, the dependencies 
of the automation pack, and the history of changes made to the automation pack.

Step 1 On the Administration workspace, click Automation Packs in the navigation pane to display the 
installed automation packs in the Automation Packs pane.

Information about the automation packs display in the following columns:

Step 2 Select the automation pack in the Automation Packs pane, right-click and choose Properties.

Column Description

Company Name Name of the company that released the automation 
pack.

Publish Date Date the automation pack was created or exported to a 
file.

Version Version number of the automation pack.

Display Name Name of the automation pack.

ID Identification number of the automation pack.

Import Date Date the automation pack was imported into the 
product.

Licensed Indicates whether the automation is a licensed product 
in Process Orchestrator.

Description Text description of the automation pack.
2-1
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Chapter 2      Understanding Automation Pack Objects
  Accessing Automation Pack Properties
Step 3 On the Properties dialog box, select the appropriate tab to view the automation pack properties:

Step 4 Click Close to close the dialog box.

Tab Description

General Displays general information about the automation 
pack.

Objects Display a list of objects contained in the automation 
pack.

Dependencies Display a list of automation packs and adapters 
referenced by the objects in the automation pack.

History Displays when the automation pack was created or 
modified, and audit log entries that are relevant to the 
automation pack.
2-2
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  Viewing Automation Pack Content and Dependencies
Viewing Automation Pack Content and Dependencies
Use the automation pack Properties dialog box to view the objects contained in the automation packs 
and the dependencies associated with the automation pack.

Note See Appendix A, “Core Automation for SAP BW, BOBJ and In-Memory Computing Automation Pack 
Content”for information on the content included in the dependent automation pack. 
 
See Appendix B, “Understanding the Common Activities Content”for information on the content 
included in the dependent automation pack.

Viewing Automation Pack Content

Step 1 On the Administration—Automation Packs view, select Automation for SAP BOBJ Accelerator, 
right-click and choose Properties.

Step 2 On the Automation for SAP BOBJ Accelerator Properties dialog box, click the Objects tab.
2-3
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Chapter 2      Understanding Automation Pack Objects
  Viewing Automation Pack Content and Dependencies
Step 3 On the Objects tab, review the information about the objects provided by the Automation for SAP BOBJ 
Accelerator automation pack.

Automation for SAP BOBJ Accelerator Processes

The following table contains the processes that are imported by the Automation for SAP BOBJ 
Accelerator automation pack.

Columns Description

Display Name Name of the object (processes, global variables, 
knowledge base).

Type Object type.

Action Required Action required to successfully import or export the 
objects.

Description Text description of the object.

Version Object version.

Process Name Description

BOBJ Data Services Availability This process tests the web services connection to the 
BOBJ XI Data Services server and alerts if the server is 
unavailable.

BOBJ Data Services Job Duration 
Monitoring

This process monitors the duration of selected data 
services jobs.

BOBJ Data Services Job Error Monitoring This process monitors all or selected (global variable 
wildcard) data services jobs for warning or error status 
and returns error, monitor, and trace logs. An approval 
request with corrective action to restart job allows the 
user to restart failed jobs.

BOBJ Resolve Long Running Background 
Jobs

This process is triggered by an incident from the BOBJ 
Data Services Job Duration Monitoring process; it 
attempts to resolve the incident by stopping the 
background job.

BWA TREX  Alert Monitoring This process monitors BWA alerts.

BWA TREX  Automate Actions This process automates the execution of recommended 
BWA actions.

BWA TREX Checklist This process is a monitoring checklist for BWA TREX.

BWA TREX Execute Index Query This process monitors the execution response time of 
custom defined TREX against the TREX index schema.

BWA TREX  Monitor Load Statistics This process monitors BWA TREX load statistics.

BWA TREX  Status Check This process monitors BWA TREX status.

Search TREX Trace Logs The process executes a search of the TREX trace logs 
and returns the results and response time.
2-4
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Automation for SAP BOBJ Accelerator Target Properties

The following table contains the target properties that are imported by the Automation for SAP BOBJ 
Accelerator automation pack.The target properties that do not have a value defined must be configured 
by the user prior to using them in processes. 

Automation for SAP BOBJ Accelerator Task Rules

The following task rules are imported with the Automation for SAP BOBJ Accelerator automation pack:

Target Property Name Description
Value 
Defined?

BOBJ DS Database Target This property is used to create a PO database target 
for each BOBJ DS and add references to them in 
this property.

No

BOBJ DS Job Duration 
Monitoring

This property contains a list of BOBJ Data Services 
jobs to monitor and the maximum duration (in 
seconds) the jobs took to complete.

Note The Job Name column does not accept 
wildcards and is case sensitive.

No

BOBJ DS Jobs to Monitor for 
Errors

This property monitors the BOBJ Data Services 
jobs (wildcard) for errors.

Enter * in the BOBJ Server column if the same job 
is to be monitored in all servers.

No

BOBJ DS Repository This property is used to enter the name of the BOBJ 
repository to be used in the Web Services calls.

No

BOBJ DS Web Target This property is used to create a PO web target for 
each BOBJ DS and add references to them in this 
property. 

No

BOBJ DS Web Service Account This property contains the name of the account to be 
used to connect to the BOBJ Web Service. The user 
account and password are entered as WSDL 
parameter.

No

BOBJ DS Web Service Password This property contains the password to be used to 
connect to the BOBJ Web Service.

No

BWA TREX Alert Monitoring This property is used for BWA alert monitoring. No

BWA.TREX.Alert Monitoring – 
Actions

This property is used for BWA alert monitoring 
problem resolution.

No

Target Group Name Description

BOBJ Default Incident Assignment Default assignment for BOBJ incidents.
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Automation for SAP BOBJ Accelerator Target Groups

The following target groups are imported with the Automation for SAP BOBJ Accelerator automation 
pack:

Viewing Automation Pack Dependencies

Step 1 On the Administration—Automation Packs view, select Automation for SAP BOBJ Accelerator, 
right-click and choose Properties.

Step 2 On the Automation for SAP BOBJ Accelerator Properties dialog box, click the Dependencies tab.

Step 3 Review the list of automation packs and adapters referenced by the Automation for SAP BOBJ 
Accelerator automation pack. 

Step 4 Click Close to close the dialog box.

Target Group Name Description

BOBJ DS Targets Contains all BOBJ Data Services targets.

Object Type Dependency

Automation Packs  • Core

 • Core Automation for SAP BW, BOBJ and In-Memory 
Computing

 • Common Activities

Adapters  • Core Functions Adapter

 • Terminal Adapter

 • Oracle Database Adapter

 • Web Service Adapter

 • Microsoft SQL Server Database Adapter

 • IBM DB2 Database Adapter
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C H A P T E R 3

Getting Started Using the Automation Pack

Before you begin using the content that ships with the automation pack, you must create the objects in 
Process Orchestrator that are referenced in the processes. These objects include targets, runtime users, 
task rules for assignments and notifications, and target properties.

This chapter provides basic information on defining the objects. It includes the following sections:

 • Creating a Runtime User, page 3-2

 • Creating and Configuring Targets, page 3-3

 • Managing Target Properties, page 3-12

 • Using Task Rules for Assignments and Notifications, page 3-13

For additional information about the objects discussed in this chapter, refer to the following 
documentation:

Document Description

Cisco Process Orchestrator User Guide General information about Core product features.

Cisco Process Orchestrator Online Help Information about the objects specific to the Web Services 
Adapter (runtime user, target, and activities).
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Creating a Runtime User
The Runtime User is the account that will be used to connect to the Web or Database target that is 
referenced in the BOBJ DS target properties. 

Note For additional information on creating and managing runtime users, see the Cisco Process Orchestrator 
User Guide.

Step 1 In the Definitions workspace, right-click Runtime Users and choose New > Runtime User to open the 
New Runtime User Properties dialog box.

Step 2 On the General tab, specify the following information:

Note The Required Value  icon displayed on a tab or page indicates that the field is required and 
is either missing a value or contains an invalid value.

Note The Used By tab displays objects used by the runtime user and will remain blank until used by 
an object. 
 
The History tab displays the history of actions taken against the runtime user and will remain 
blank until after the initial creation.

Step 3 Click OK to close the dialog box.

Field Description

Display name Name for the user account. This field can populated 
with the information specified in the Domain and User 
name text fields, or you can enter a different name to 
display for the user account.

User name User name assigned to the user account that connects to 
the Remedy Server target.

Password Check the check box and enter the password assigned 
to the user account.

Note No password verification is done for the simple 
(generic) runtime user.

Description A description of the user account.
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Creating and Configuring Targets
The Automation for SAP BOBJ Accelerator automation pack includes a BOBJ DS Target Template that 
can be used to create service targets for the BOBJ DS environment. The service target will hold the 
reference to all of the connections to BOBJ DS that are needed for automation. Once the service target 
is created, you then create the Web and Database targets, and reference them in the BOBJ DS service 
target using the Target Properties feature.

In addition, you must create a BWA Unix/Linux target if you want to use the BWA TREX atomic 
processes that are included in the Core Automation for SAP BW, BOBJ and In-Memory Computing 
automation pack.

This section guides you through creating the targets and then configuring the target properties.

Creating BOBJ DS Target
Use the BOBJ DS Target Template as a basis for creating a BOBJ DS service target specific to your 
environment. You must first create a copy of the template target and then rename it.

Step 1 On the Definitions workspace, right-click Targets and choose New > BOBJ DS to open the BOBJ DS 
Properties dialog box.

Step 2 In the Display name text field, enter a name for the BOBJ DS target.

Step 3 Click OK to save the target and close the dialog box.

Step 4 In the Targets pane, right-click the newly created BOBJ DS target and choose Enable to enable the 
target.
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Creating Web Target
To monitor the BOBJ DS server, you need to go to a Web target and then reference it in the BOBJ DS 
service target properties.

Use the New Web Target Properties dialog box to create the Web target.

Step 1 On the Definitions workspace, right-click Targets and choose New > Web Target to open the New Web 
Target Properties dialog box.

Step 2 On the General tab, enter the information in the following text fields:

Step 3 Click the Connection tab.

Note The Required Value  icon displayed on a tab or page indicates that the field is required and 
is either missing a value or contains an invalid value.

Step 4 On the Connection tab, specify the following connection information for the target:

Field Description

Display name Name for the target. This is the name that will display in 
the Targets pane.

Type Display only. Type of target.

Owner User name of the owner of the target. This is typically the 
person who created the target.

Status Display only. Status of the target.

Status information Display only. Detailed information regarding the target 
status.

Organization Name of the company that supports the target.

Description Optional field to enter a description for the target.

Field Description

Base Url Enter the appropriate target URL to use as a base for the 
execution.

For example:
http://doc-bobj-xidev.domain.local:8080/BOE/CMC
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Step 5 Click OK to close the dialog box and complete the procedure.

The Web target displays in the Targets pane.

Creating BOBJ DS Database Target
Use the New Database Properties dialog box to create the BOBJ DS Database target.

Note The screens in this section will differ depending on the type of database you are creating. See the 
appropriate Cisco Process Orchestrator Online Help for additional information on creating database 
targets.

Step 1 On the Definitions workspace, right-click Targets and choose New > [Database Type] to open the New 
Database Properties dialog box.

Step 2 On the General tab, specify the following information:

Runtime User Click one of the following radio buttons to indicate 
which runtime user account to use to connect to the 
target:

 • No runtime user—Select this radio button to 
indicate that no runtime user is required to execute 
a process or activity against the target.

 • Default runtime user—Select this radio button and 
then choose the default runtime user account that 
contains the credentials to connect to the target.

Note To view the properties for the selected runtime 
user, click the Properties  tool. 
 
To create a new runtime user account, click 
New and then choose Runtime User or 
Windows User.

Ignore certificate errors Check or uncheck the check box to indicate whether the 
target should ignore any certificate errors on the 
specified web site. If the check box is checked, all 
errors will be ignored.

Field Description

Field Description

Display name Enter a name for the Database target. This is the name 
that will display in the Targets pane.

Type Display only. Type of target.

Owner User name of the owner of the target. This is typically 
the person who created the target. Click the Browse  
tool to change the owner.
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Step 3 Click the Connection tab.

Note The Required Value  icon displayed on a tab or page indicates that the field is required and 
is either missing a value or contains an invalid value.

Step 4 Specify the connection information for connecting to the database:

Step 5 Click OK to close the dialog box.

The database target displays in the Targets pane.

Creating BWA Unix/Linux Target
If you want to run the BWA TREX atomic processes that are included in the Core Automation for SAP 
BW, BOBJ and In-Memory Computing automation pack, you must create the BWA Unix/Linux System 
target.

Status Display only. Status of the target.

Status information Display only. Detailed information regarding the target 
status.

Organization Name of the company or business unit that supports the 
target.

Description Optional field to enter a description for the target.

Enabled Check or uncheck the check box to enable or disable the 
target. The check box is checked by default.

Field Description

Field Description

Server Name or the IP address for the database server.

Database name Name of the database.

Database owner Principal owner of the database.

Default timeout for activities (seconds) Length of time to wait before a command is complete.

Default runtime user Choose the user account that contains the credentials to 
connect to the target from the drop-down list.

 • To view the properties for the selected runtime user, 
click the Properties  tool. 

 • To create a new Runtime User, click New > Runtime 
User. 

Connection string Check the check box to enter the connection string for 
connecting to the database.
3-6
Process Automation Guide for Automation for SAP BOBJ Accelerator

OL-30852-01



 

Chapter 3      Getting Started Using the Automation Pack
  Creating and Configuring Targets
Note For additional information on creating and managing Unix/Linux System targets, see the Cisco Process 
Orchestrator Online Help.

Step 1 On the Definitions workspace, right-click Targets and choose New > Unix/Linux System to open the 
New Unix/Linux System Properties dialog box.

Step 2 On the General tab, specify the following information:

Step 3 Click the Connection tab. 

Note The Required Value  icon displayed on a tab or page indicates that the field is required and 
is either missing a value or contains an invalid value.

Step 4 On the Connection tab, specify the connection information to connect to the Unix/Linux server: 

Field Description

Display name Enter a name for the Database target. This is the name that 
will display in the Targets pane.

Type Display only. Type of target.

Owner User name of the owner of the target. This is typically the 
person who created the target. Click the Browse  tool 
to change the owner.

Status Display only. Status of the target.

Status information Display only. Detailed information regarding the target 
status.

Organization Name of the company or business unit that supports the 
target.

Description Optional field to enter a description for the target.

Enabled Check or uncheck the check box to enable or disable the 
target. The check box is checked by default.

Field Description

Host name Host name or IP address of server.

Port Port number used to access the server.
3-7
Process Automation Guide for Automation for SAP BOBJ Accelerator

OL-30852-01



 

Chapter 3      Getting Started Using the Automation Pack
  Creating and Configuring Targets
Step 5 Click the Authentication tab to indicate whether the target should allow authentication based on the host 
system. 

Users can define default host public and private keys on the Terminal Adapter settings. This tab allows 
users to select a specific private key for the target. The private key will be used for host-based 
authentication if a target does not specify its own keys. 

Prompt prefix Enter the command prompt prefix that will be used by 
the device type configurations and expects when issuing 
commands and connecting to the device.

Adding a regex character, such as $, >, and #, at the end 
of a prompt in the Prompt Prefix field invalidates the 
command prompt prefix. 

Regular expressions should be placed in the appropriate 
Terminal Interaction Pattern fields. See Step 9 to 
customize the interaction patterns on the Advanced tab.

Example:
Unix system prompt prefix is defined by the user default 
login script. it usually contains username, node name or 
current directory name. If the user does not define 
anything, the prompt prefix is empty.

If you connect to the terminal, and the prompt is 
jsmith@TBD-SH03-IT ~$, enter the regular 
expression that will match the entire prefix (before #) 
using any of the following expressions:

 • .*TBD-SH03-IT.*

 • \[\w+@TBD-SH03-IT.*\]

Default runtime user Choose the default runtime user account that contains 
the credentials to connect to the target from the 
drop-down list. 

To view the properties for the selected runtime user, 
click the Properties  tool. 

To create a new runtime user account, click New > 
[Runtime User Type] to create a new Runtime User 
account. 

Enable code injection prevention Check this check box to enable the protection which 
prevents code that is injected to exploit the security 
vulnerability.

Maximum allowed concurrent sessions Enter the maximum allowed open sessions to run 
concurrently (default value is 3).

If the user tries to open new session via Open Session 
activity, it will wait in a queue until there is a session 
available to open.

Field Description
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Step 6 On the Authentication tab, specify the following information:

Step 7 Click the Advanced tab. 

Step 8 On the Advanced tab, configure the interaction patterns for the target. 

Step 9 To customize the interaction patterns, complete the following fields, as necessary.

Field Description

Use host-based authentication Check this check box to indicate that host-based 
authentication will be used with this target. 

If this check box is unchecked, then host-based 
authentication will not be used.

Use the default host keys This check box becomes enabled after the Use host-based 
authentication check box is checked. 

Check this check box to indicate the host keys defined on 
the Terminal Adapter property page will be used for this 
target. 

If this check box is unchecked, then the user will need to 
load the appropriate private key to be used to validate this 
target.

Private key This box becomes enabled only if the Use the default host 
keys check box is unchecked.

To the right of the display-only field, click the Browse  
tool to launch the Load Private Key dialog box and select a 
private key. 

Field Description

Use patterns common for the following 
device 

Click the radio button one of the pre-defined device 
targets from the drop-down list.

 • Cisco IOS Device—Select this option to use the 
default pattern values used by the device during the 
completion of a session command.

 • Unix/Linux System—Select this option to use the 
default pattern values indicated for a Unix or Linux 
system during the completion of a session 
command.

To view the properties for the selected device, click the 
Properties  tool.

To create a new device, click New > Expect Template 
to create a new expect template.

Customize patterns for this target Select this radio button to enable the display-only 
sections in order to customize the default values for the 
selected device type. 
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Note Click the Reference  tool to select a defined variable or reference an object within the 
process from the Insert Variable Reference dialog box. 
 
Click the Expression  tool to add a regular expression in the field. 

Step 10 To modify the list of login expects, click the following buttons, as necessary. 

Step 11 To elevate the privilege command for login expects: 

Step 12 Click OK to close the dialog box.

The new target displays in the list of targets on the Definitions—Targets view. 

Configuring References to Targets
You must now configure the BOBJ DS target to reference the Web target and Database target. Use the 
Target Properties feature to reference the targets. 

Field Description

Prompt Enter the system prompt pattern in regular expression.

Error Enter the error message pattern in regular expression.

Admin prompt Enter the admin prompt pattern in regular expression.

Button Description

Add Click Add to launch the Expect dialog box to configure 
the expect parameters to be added to the list.

Edit Highlight the appropriate item and click Remove to 
remove the item from the list.

Remove Highlight the appropriate item and click Edit to launch 
the Expect dialog box to modify the expect parameters 
in the list.

Up and Down Arrows Highlight the appropriate item and then click the up or 
down arrow to move the item up or down in the list.

Field Description

Elevating Privilege command Check this check box and in the text field, enter the 
command or select the reference variable containing the 
command to elevate the privilege for the expect.

Elevating Privilege expects Use this section to view and/or define the login expect 
sequence for the elevating privilege command expects. 
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Creating Reference to BOBJ DS Web Target

Step 1 On the Definitions workspace, click Targets. 

Step 2 Right-click the BOBJ DS target and choose Properties.

Step 3 On the BOBJ DS Service Target Properties dialog box, click the Properties tab.

Step 4 Select the BOBJ DS Web Target property and click Edit.

Step 5 On the Target Property Value dialog box, click the Browse  tool next to the Value field.

Step 6 On the Select Target dialog box, select the BOBJ DS Web target and click OK.

Step 7 Click OK to close the Target Property Value dialog box.

Step 8 If you have completed adding target references, click OK to close the BOBJ DS Target Properties dialog 
box.

Creating Reference to BOBJ DS Database Target

Step 1 On the Definitions workspace, click Targets. 

Step 2 Right-click the BOBJ DS target and choose Properties.

Step 3 On the BOBJ DS Service Target Properties dialog box, click the Properties tab.

Step 4 Select the BOBJ DS Database Target property and click Edit.

Step 5 On the Target Property Value dialog box, click the Browse  tool next to the Value field.

Step 6 On the Select Target dialog box, select the Web target and click OK.

Step 7 Click OK to close the Target Property Value dialog box.

Step 8 If you have completed adding target references, click OK to close the BOBJ DS Target Properties dialog 
box.
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Managing Target Properties
The BOBJ Accelerator processes use target properties to specify the values to be used for certain target 
properties. This section provides information on configuring the target properties that ship with the 
Automation for SAP BOBJ Accelerator automation pack. 

Accessing Target Properties
The target properties that ship with the Automation for SAP BOBJ Accelerator automation pack can be 
accessed from the Definitions—Target Properties view. 

Step 1 On the Console, select the Definitions workspace and click Target Properties in the navigation pane. 
By default, all the properties display in the Target Properties pane.

The following information about the target properties displays by default:

Step 2 Click the Filter by link and choose Automation Pack > Automation for SAP BOBJ Accelerator to 
filter for only the target properties that ship with the specific automation pack.

Column Description

Display Name Name of the target property.

Description Text description of the target property.

Value Value assigned to the target property.

Data Type Type of value being used for the target property 
(Boolean, Encrypted String, Identity, Numeric, String, 
Table).

Automation Pack Name of the automation pack that provides the target 
property.

Customizable Indicates the customization setting for the target 
property in the automation pack.

Target Types Indicates the targets associated with the target property.

Last Modified Time Date and time the variable was last modified.

Last Modified By Name of the user who last modified the target property.

Id Unique ID of the target property.

Owner User name of the owner of the target property. This is 
typically the person who created the target property.

Created Time Date and time the target property was created.

Created By User name of the person who created the target 
property.
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Configuring Target Properties
You use the Target Properties dialog box to view or modify the target property. You access the properties 
from the Definitions—Target Properties view.

The following section provides information on configuring target properties that ship with the 
Automation for SAP BOBJ Accelerator automation pack.

Step 1 On the Target Properties pane, right-click [Target Property] and choose Properties.

Step 2 On the General tab, review the information in the Description field to determine the values that need to 
be specified for the target property.

Step 3 Click the Value tab to view or modify the default value for all targets.

Note The tab in the second position will depend on the variable type. See the Cisco Process 
Orchestrator User Guide for instructions on configuring the different types of target properties.

Step 4 Click in the cell to specify the default value or change the default value for all targets.

Step 5 Click the Target Values tab to specify the targets that should be used to override the default value.

Step 6 Click New to add a new target override.

Step 7 On the Target Property Value dialog box, click Add to choose the target to be used for the override value. 
This is the target that will be monitored for a value other than the default value. 

Step 8 Select the target and click OK.

Step 9 On the Target Property Value dialog box, enter the information in the Value area to be used for the 
specified target and then click OK.

The target override displays on the Target Values tab.

Step 10 Click OK to close the dialog box and save your changes.

Note The Target Types tab is only available if you have explicit rights to the object. See the Cisco 
Process Orchestrator User Guide for information on using this property page.

Using Task Rules for Assignments and Notifications
Task rules are used to manage task assignments and notifications for tasks, such as incidents and alerts, 
that are generated from processes. The Core Automation for SAP BW, BOBJ and In-Memory Computing 
automation pack ships with a default assignment task rule that must be configured if you want a specific 
person or group to receive assignments for BOBJ incidents.

Note If you do not want to create task rules for email notifications, you can use the default notification based 
on assignment processes that ship with the Core automation pack. These processes are disabled by 
default and must be enabled if you want notifications to be sent (see Enabling Notification Based on 
Assignment Processes, page 3-23).
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Accessing Task Rules View
Use the Definitions—Task Rules workspace to access task rules. 

Step 1 On the Console, select the Definitions workspace and click Task Rules in the navigation pane. By 
default, all the rules display in the Task Rules pane.

Step 2 Click the Filter by link and choose Automation Pack > [Automation Pack Name] to filter for only the 
task rules that ship with a specific automation pack.
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The following information about the task rules displays by default: 

Configuring Task Rules
Use the Task Rules view to configure the task rule that ships with the Core Automation for SAP BW, 
BOBJ and In-Memory Computing automation pack.

BOBJ Default Incident Assignment

The BOBJ Default Incident Assignment task rules is used to specify the default user or group who will 
be assigned all BOBJ-related incidents unless otherwise specified in task rules. 

Step 1 In the Definitions workspace, click Task Rules in the navigation pane to display the task rules in the 
results pane.

Step 2 Click the Filter by link and choose Automation Pack, and then choose Core Automation for SAP BW, 
BOBJ and In-Memory Computing from the drop-down list to display the task rules that ship with the 
automation pack.

Step 3 Right-click the BOBJ Default Incident Assignment task rule and choose Properties to open the BOBJ 
Default Incident Assignment Properties dialog box.

Step 4 Click the Assign tab to specify the user or group that should receive assignments for incidents and alerts 
generated by the processes.

Step 5 On the Assign tab, click Add to open the Select Assignee to Add dialog box.

Step 6 On the Select Assignee to Add dialog box, specify the assignees using one of the following methods:

Column Description

Display Name The name assigned to the task rule. 

Enabled Indicates whether the task rule is enabled (True) or 
disabled (False). A disabled task rule is unavailable for 
execution.

Type Type of task.

Owner User name of the person or group who assigned the task 
rule.

Last Modified Time The date and time the task rule was last modified.

Last Modified By The object or user name that last modified the task rule.

Id Unique ID of the task rule. 

Description Brief description of the task rule.

Type Description Brief overview of the task rule type.

Created Time Time at which the task rule was created.

Created Date Date the task rule was created.

Automation Pack Name of the automation pack associated with the task rule.
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 • Click the Reference  tool to select the appropriate variable reference containing the assignee or 
list of assignees from the Insert Variable Reference dialog box.

 • Click the Browse  tool to launch the Select User or Group dialog box to add user to the list of 
assignees.

Step 7 Click OK to add the assignee to the task rule.

Step 8 When you have completed adding assignees to the task rule, click OK to close the dialog box.
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Creating Task Rules
Use the Task Rules view to create a new task rule. The procedure is the same for all types of task rules 
with the exception of the task-specific tab (Assign, Notify, Update) for the type of task rule you are 
creating.

Note Only users with administrative rights can create task rules in Process Orchestrator. 

You can create the following types of task rules:

Step 1 In the Definitions workspace, right-click Task Rules and choose New > [Task Rule Type] to open the 
New Rule Properties dialog box. 

Step 2 On the General tab, enter the following information:

Step 3 Click the Task Types tab to specify the types of tasks to be executed by the rule.

Step 4 Check the check box for the type of task that will execute the rule. 

Task Rules Description

Assign Task Rule Assigns users to a task. 

Notify Task Rule Notifies users that a task has been created.

Update Task Rule Specifies the properties to be updated in a task..

Field Description

Display Name Name of the task.

Type Display only. Shows the type of object.

Trigger Display only. Type of trigger associated with the task rule.

Owner User name of the owner of the task rule. This is typically 
the person who created the task rule. 

Click the Browse  tool to launch the Select User or 
Group dialog box to change the owner.

Description A brief description of the task rule.

Enabled The check box is checked by default to indicate that the 
task rule is available for execution. 

Uncheck the check box to disable the task rule.  If the check 
box is unchecked, the task rule is disabled and will be 
unavailable for execution.

Task Type Description

Alert Alerts reflect potential problems that a user may want 
to investigate and possibly diagnose the problem.

Approval Request Specifies the message and choices for the assignee who 
is approving the task.

Guided Operation Details the steps a user takes to complete an assigned 
task.
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Step 5 Click the Conditions tab to specify the conditions of when the task rule action is to be taken based on 
an evaluation of the defined conditions. 

Note The Required Value  icon displayed on a tab or page indicates that the field is required and 
is either missing a value or contains an invalid value.

Step 6 On the Conditions tab, define the conditions that must be met for the rule to execute.

Defining a Basic Condition:

a. On the Basic page, click New to add a new property for the condition that must be met.

b. In the Property text field, click the Reference  tool to choose a defined variable or reference an 
object on the Insert Variable Reference dialog box.

c. Choose the condition expression from the drop-down list.

d. Enter the condition description in the text box or click the Reference  tool to choose a defined 
variable or reference an object on the Insert Variable Reference dialog box.

e. Click New to define additional properties, if necessary.

Defining an Advanced Condition:

a. Click the Advanced tab to define a specific type of condition (Compound, Prior Process Instance, 
Time, or Variable).

b. Click the link to modify the option for the condition equation. 

c. Click New and choose the type of condition from the drop-down list.

d. Specify the relevant information for the type of condition selected.

Note Click New. Click the Reference  tool to choose a defined variable or reference an object 
on the Insert Variable Reference dialog box.

e. Click New to define additional properties, if necessary.

Step 7 Click the task rule specific tab (Assign, Notify, or Update) and specify the relevant information for the 
specific type of rule.

Incident Task requires an operator to take action in order to 
resolve an issue.

Input Request Task requires input from an individual or group.

Review Task assigns a document for review.

Task Type Description

Option Description

AND condition (all conditions must be met) Click this option if an action is to be taken only when 
all conditions in the list are true.

OR condition (one condition must be met) Click this option if an action is to be taken when one 
condition in the list is true.
3-18
Process Automation Guide for Automation for SAP BOBJ Accelerator

OL-30852-01



 

Chapter 3      Getting Started Using the Automation Pack
  Using Task Rules for Assignments and Notifications
Assign Task Rule

If you are creating an Assign Task Rule, the Assign tab displays on the New Rule Properties dialog box.

On the Assign tab, specify the assignees for task rule. 

Field Description

Add Click this button to launch the Select Assignee to Add 
dialog box to specify the assignees. 

On the Select Assignee to Add dialog box, use one of the 
following methods to specify the assignee:

 • Click the Reference  tool to select the appropriate 
variable reference containing the assignee or list of 
assignees from the Insert Variable Reference dialog 
box.

 • Click the Browse  tool to launch the Select User or 
Group dialog box and add user to the list of assignees.

Edit Select the appropriate assignee in the list and click this 
button to view or modify the assignee of the task rule. 

Remove Select the appropriate assignee and click this button to 
remove the assignee from the list.

Remove All Click this button to remove all specified assignees from the 
list.
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Notify Task Rule

If you are creating a Notify Task Rule, the Notify tab displays on the New Rule Properties dialog box.

On the Notify tab, specify the recipients of the notification that the task rule has executed. You can add 
individual recipients or include a notification recipient list.

Update Task Rule

If you are creating an Update Task Rule, the Update tab displays on the New Rule Properties dialog box.

On the Update tab, specify the properties to be updated after the task rule has executed. 

Field Description

Add notification recipients Displays list of users to be notified by the task rule.

 • Add—Click this button to launch the Select 
Notification Recipient to Add dialog box to specify 
the recipients. 

On the dialog box, enter the email address for the 
recipient or click the Reference  tool to select 
the appropriate variable reference containing the 
recipient or list of recipients from the Insert 
Variable Reference dialog box and then click OK.

 • Edit—Select the appropriate recipient in the list 
and click this button to view or modify the recipient 
of the task rule. 

 • Remove—Select the appropriate recipient in the 
list and click this button to remove the recipient 
from the list.

 • Remove All—Click this button to remove all 
specified recipients from the list.

Add notification recipient list Click the Reference  tool to select the appropriate 
variable reference containing list of recipients from the 
Insert Variable Reference dialog box. 

Field Description

Add Click this button to add a new property to the Properties to 
update area.

Remove Click this button to remove the last property added to the 
Properties to update area.

Property From the Property drop-down list, choose the item to 
update within the task. The properties displayed depend on 
the selected item.

List action Choose the appropriate item from the drop-down list to 
determine which action to take with the selected property:

 • Add Item—Adds item to task.

 • Remove item—Removes item from task.

 • Clear—Removes property value from task.

Value Enter new value for the property.
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Step 8 Click OK to save the task rule definition and close the dialog box.

Managing Task Rule Definitions 
This section provides instructions on modifying task rules in the Definitions—Task Rule view. Only 
users with administrative rights can modify task rules in Process Orchestrator.

Note For additional information on managing task rules, see the Cisco Process Orchestrator User Guide.

Enabling a Task Rule 

A task rule is enabled by default. If a task rule is manually disabled, the task rule must be enabled before 
it is available for execution. 

On the Definitions—Task Rules view, select the task rule and then use one of the following methods to 
enable it:

 • On the Results pane, right-click and choose Enable. 

-or-

 • On the Details pane, select Click here to enable.

The Enabled column on the Results pane changes to True. If necessary, click the Refresh  tool to 
update the view.

Disabling a Task Rule

Disabling a task rule prevents the item from being available for execution. The disabled task rule is not 
removed from the list of task rules on the Definitions—Task Rules Results pane.

On the Definitions—Task Rule view, select the task rule and then use one of the following methods to 
disable it:

 • On the Results pane, right-click and choose Disable. 

-or-

 • On the Details pane, select Click here to disable.

The Enabled column on the results pane changes to False. If necessary, click the Refresh  tool to 
update the view.
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Creating a Copy of a Task Rule

The copy option is used when the user wants to leverage an existing task rule to define a new task rule 
using existing properties. 

Step 1 On the Definitions—Task Rules view, select the appropriate task rule, right-click and choose Copy.

Step 2 On the Results pane, right-click and choose Paste.

A copy of the defined task rule is pasted onto the Results pane.

Step 3 To rename the copied task rule or other properties, right-click and choose Properties.

Step 4 Modify the task rule name, as appropriate, and click OK to close the dialog box.

Sorting Task Rules

The task rules are executed according to the order they are listed on the Definitions—Task Rules view. 
You should sort the task rules based on the order in which you want them to execute.

Note All task rules will execute even if there is more than one task rule assigned for the same condition. For 
example, if you have two assignment rules for the same incident, both rules will be executed in the order 
listed in the Task Rules view.

On the Definitions—Task Rules view, select the task rule and use one of the following methods to move 
it to the desired position in the list:

 • Drag and drop the task rule into the appropriate position in the list.

 • On the Actions toolbar, click Move Up or Move Down.

 • Click the Actions menu and choose Move Up or Move Down.

 • Right-click and choose Move Up or Move Down.

The list of task rules are sorted according to the selected action. 

Deleting a Task Rule

Use the Definitions—Task Rules view to delete task rules that are no longer used.

Step 1 On the Definitions—Task Rules view, select the task rule, right-click and choose Delete.

Step 2 On the Confirm Delete dialog box, click Yes to confirm the deletion. 
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Enabling Notification Based on Assignment Processes
If you want to have emails sent to whoever is assigned to a task but do not want to create notification 
task rules, you can enable the processes that ship with the Core automation pack that send emails based 
on assignment.

When these processes are enabled, the user or user group who was assigned to tasks will receive the 
email notification.

Step 1 In the Definitions workspace, click Processes.

Step 2 Click the Filter by link and choose Automation Pack > Core to filter for the processes that ship with 
the Core automation pack.

Step 3 Right-click the appropriate Notification Based on Assignment process and choose Enable.

The following processes are for notification based on assignment:

Process Name Description

Default Alert Notification Based on 
Assignment

Sends email when an alert gets assigned.

Default Approval Request Notification 
Based on Assignment

Sends email when an approval request gets assigned.

Default Change Request Notification Based 
on Assignment

Sends email when an change requests gets assigned.

Default Guided Operation Request 
Notification Based on Assignment

Sends email when a guide operation request gets 
assigned.

Default Incident Notification Based on 
Assignment

Sends email when an incident gets assigned.

Default Input Request Notification Based on 
Assignment

Sends email when an input request gets assigned.

Default Review Request Notification Based 
on Assignment

Send email when a review request gets assigned.
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Managing Automation for SAP BOBJ Accelerator 
Processes

This chapter provides information on using the product, specific to the Automation for SAP BOBJ 
Accelerator automation pack. It includes information on accessing the Automation for SAP BOBJ 
Accelerator processes and filtering for specific processes, managing the processes, starting a process, 
and viewing a running process, its results, and the automation summary generated by the process.

It includes the following sections:

 • Accessing Automation for SAP BOBJ Accelerator Processes, page 4-2

 • Managing Automation for SAP BOBJ Accelerator Processes, page 4-3

 • Running Processes, page 4-6

 • Viewing Process Results, page 4-8

 • Viewing Automation Summary, page 4-10

Note Before you can run the Automation for SAP BOBJ Accelerator processes, you must configure the objects 
that are referenced by the processes and activities. See Chapter 3, “Getting Started Using the Automation 
Pack” for information on configuring the objects in Process Orchestrator.
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Accessing Automation for SAP BOBJ Accelerator Processes
The processes that ship with the product can be accessed from the Definitions—Processes view.

Step 1 On the Console, select the Definitions workspace and click Processes in the navigation pane. By default, 
all the processes display in the Processes pane. 

If you have multiple automation packs installed, you can filter the processes to display the processes 
specific to the automation pack.

Step 2 In the upper portion of the Processes pane, click the Filter by link and choose Automation Pack.

Step 3 In the drop-down list, choose Automation for SAP BOBJ Accelerator.

The processes display in the Processes pane.
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Managing Automation for SAP BOBJ Accelerator Processes
This section provides information on managing the Automation for SAP BOBJ Enterprise processes, 
including:

 • Enabling and disabling processes

 • Enabling and disabling the process archival feature

 • Modifying a process schedule

Enabling a Process
Some of the processes that ship with the automation packs are disabled by default to reduce the load on 
the server or because they require user configuration. 

Perform the following steps to enable a process.

Step 1 In the Processes view, navigate to the process that you want to enable (disabled processes appear 
dimmed).

Step 2 Use one of the following methods to enable the process:

 • Right-click the process and choose Enable from the submenu.

 • In the Process Editor, click the General tab and then check the Enabled check box. Click the Save 
 tool to save your changes to the process and close the Process Editor.

Disabling a Process
Disabling a process prevents the process from executing. You may want to disable some processes to 
reduce the load on your server or while you are modifying the process definition.

Perform the following steps to disable a process.

Step 1 In the Processes view, navigate to the process that you want to disable.

Step 2 Use one of the following methods to disable the process:

 • Right-click the process and choose Disable from the submenu.

 • In the Process Editor, click the General tab and then uncheck the Enabled check box. Click the 
Save  tool to save your changes to the process and close the Process Editor.
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Modifying Process Instance Archival
Process Orchestrator provides an option in the process definition that allows you to choose whether or 
not to archive process and activity execution in the Process OrchestratorProcess database. Disabling the 
archive option helps improve performance and minimizes the size of the database. It is also useful when 
debugging the execution of processes.

If you want to view the execution of a process and its activities, or view the process instances after a 
process has completed, you must enable the archival functionality in the process definition.

Perform the following steps to enable or disable the archival feature.

Step 1 In the Processes view, navigate to the process you want to flag for archival.

Step 2 Right-click the process and choose Edit from the submenu.

Step 3 On the process Properties dialog box, click the Options tab.

Step 4 On the Options tab, click one of the following radio buttons to indicate how you want to archive the 
process instance.

Modifying a Process Schedule
Many of the processes that ship with the automation packs are triggered by a schedule. You can modify 
when the process will be executed by disabling the existing schedule and then creating a new schedule 
for the process. You use the process Properties dialog box to modify the process schedule.

Perform the following steps to assign a new schedule to a process.

Step 1 In the Processes view, navigate to the process that you want to modify.

Step 2 Right-click the process and choose Edit from the submenu.

Step 3 On the process Properties dialog box, click the Triggers tab.

Step 4 On the Triggers tab, right-click the current Schedule and choose Disable from the submenu.

Step 5 Click New > Schedule to open the Schedule Properties dialog box to create a new schedule for this 
process.

Step 6 On the Schedule Properties dialog box, specify the criteria for the new schedule and click OK.

Field Description

Never archive any instances Click this radio button to indicate that the process should 
not be stored upon completion.

Only archive failed instances Click this radio button to indicate that only failed instances 
should be archived.

Archive all completed instances Click this radio button to indicate that the process should 
be stored upon completion.

Archive based on condition Click this radio button to indicate that the process should 
be stored based on the condition (True/False) selected. 
Click the Browse  tool to launch the Archive Condition 
dialog box and select the condition.
4-4
Process Automation Guide for Automation for SAP BOBJ Accelerator

OL-30852-01



Chapter 4      Managing Automation for SAP BOBJ Accelerator Processes
  Managing Automation for SAP BOBJ Accelerator Processes
Note For information on creating schedules, see “Managing Triggers” in the Cisco Process 
Orchestrator User Guide.

The newly created schedule displays on the Triggers tab and is enabled.

Step 7 Click the Save  tool to save your changes to the process and close the Process Editor.
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Running Processes
The processes that ship with the product will run based on the trigger that was defined in the process 
definition. For processes that are triggered by a schedule, you can also manually start the process at any 
time (adhoc). This section guides you through starting a process and viewing its progress as it runs.

Note You can only view a running process and the process instances for processes that have the Archive all 
completed instances option enabled. See Modifying Process Instance Archival, page 4-4 for information 
on enabling the archival feature on a specific process.

Starting a Process

Step 1 In the Processes view, right-click the process and choose Start Process.

The Confirm Start Process dialog box displays. 

This process is defined to run on all targets in the BOBJ DS target group. In this example, we will 
override the default target and choose a specific target on which to run the process.

Step 2 On the Confirm Start Process dialog box, check the Override target (All BOBJ DS Targets) check box 
to expand the fields on the dialog box.

Step 3 Click the Target radio button and then click the Browse  tool to open the Select Target dialog box.

Step 4 Select the target in the list and then click OK.

Step 5 On the Confirm Start Process dialog box, click OK to start the process.

The Start Process Results dialog box displays. Proceed to Viewing Running Process, page 4-7.
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Viewing Running Process
After starting the process, you can use the Process Viewer to view the process as it runs through each 
activity.

Note You can only view a running process and the process instances for processes that have the Archive all 
completed instances option enabled. See Modifying Process Instance Archival, page 4-4 for information 
on enabling the archival feature on a specific process.

Step 1 On the Start Process Results dialog box, right-click the process and choose Observe.

The Process Viewer displays the process workflow.

Step 2 View the process as it proceeds through the workflow. 

The activities within the process workflow will change to green as they complete (succeed). If an activity 
fails, an incident is created.

Step 3 When the process completes, close the Process Viewer and proceed to Viewing Process Results, 
page 4-8.
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Viewing Process Results
After a process completes, you can view the results in the Operations workspace. This section guides 
you through viewing the results from running the process.

Note You can only view a running process and the process instances for processes that have the Archive all 
completed instances option enabled. See Modifying Process Instance Archival, page 4-4 for information 
on enabling the archival feature on a specific process.

Accessing Process View

Step 1 On the Console, select the Operations workspace.

Step 2 In the navigation pane, expand Process Views and click View Adhoc (since the process was manually 
executed).

Step 3 Using the Filter by link, choose Automation Pack and then choose Automation for SAP BOBJ 
Accelerator from the drop-down list. 

Step 4 Scroll to the process and select it.

Step 5 In the View Results pane, expand the process to view each activity in the process workflow.

Step 6 Review the status of the process and each activity within the process to verify that it has succeeded.
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Viewing Activity Results
You can view the results of a specific activity within the process using the Activity Instance Properties 
dialog box. 

Step 1 In the View Results pane, scroll to the activity.

Step 2 Right-click the activity and choose Properties.

Step 3 On the activity Properties dialog box, click the Results tab.

Step 4 Click Close to close the dialog box.

Viewing Incidents
When a process detects an issue that requires action, an incident is generated. If you have configured the 
product to send notifications to a specific person in your organization, that person will receive an email 
notification whenever an incident is generated. You can also view these incidents in the Task Views on 
the Operations workspace. 

Step 1 On the Operations workspace, expand Task Views in the navigation pane and click View Incidents.

Step 2 In the View Incidents pane, choose View all tasks from the Task Assignee drop-down list to display all 
the incidents in the View Results pane.

Step 3 To view a specific incident, right-click the incident and choose Open.

The Incident Report displays in your web browser.
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Viewing Automation Summary
When incidents are generated, Process Orchestrator delivers an online Automation Summary that details 
the analysis that was performed to identify a situation that may require action. 

You can access the Automation Summary from the Tasks View on the Operations workspace.

Step 1 On the Operations workspace, expand Task Views in the navigation pane and click View Incidents.

Step 2 In the View Incidents pane, click the View all tasks radio button to display the incidents in the View 
Results pane.

Step 3 Right-click the incident and choose View Automation Summary.

The Automation Summary displays in your web browser.
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 P P E N D I X A

Core Automation for SAP BW, BOBJ and 
In-Memory Computing Automation Pack Content

The Core Automation for SAP BW, BOBJ and In-Memory Computing automation pack contains the 
default content to support SAP BW, BOBJ and In-Memory Computing automation packs. This appendix 
describes the content included in the Core Automation for SAP BW, BOBJ and In-Memory Computing 
automation pack. It includes the following sections:

 • Automation Pack Content, page A-1

 • Automation Pack Dependencies, page A-4

 • Core Automation for SAP BW, BOBJ and In-Memory Computing Activities, page A-4

 • Defining the BWA TREX Activities, page A-9

Automation Pack Content 
Use the automation pack Properties dialog box to view the content (objects) included in the automation 
pack. For instructions on accessing the automation pack properties, see Accessing Automation Pack 
Properties, page 2-1.

Core Automation for SAP BW, BOBJ and In-Memory Computing Processes
The following table contains the process that is imported by the Core Automation for SAP BW, BOBJ 
and In-Memory Computing automation pack.

Process Name Description

BOBJ Process Execution Error Raises an incident when there are errors in the execution of 
process activities contained in the BOBJ automation 
packs.
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Core Automation for SAP BW, BOBJ and In-Memory Computing Atomic 
Processes

The Core Automation for SAP BW, BOBJ and In-Memory Computing automation pack contains 
additional activities (atomic processes) for use in the SAP BW, BOBJ and In-Memory Computing 
processes. These are additional activities that display in the Process Editor toolbox after the user has 
imported the automation packs.

See Core Automation for SAP BW, BOBJ and In-Memory Computing Activities, page A-4 for 
information on the activities and how to use them. 

Core Automation for SAP BW, BOBJ and In-Memory Computing Target 
Properties

The following table contains the target properties that are imported by the Core Automation for SAP BW, 
BOBJ and In-Memory Computing automation pack.

For instructions on configuring target properties , see Managing Target Properties, page 3-12.

 Target Property Description

BWA.Direct TREX.Path to Scripts This property contains the path to the Process 
Orchestrator scripts that were installed to the TREX 
servers.

BWA.TREX.Index Query This property contains the custom defined TREX and 
the response  time threshold values to be used for 
monitoring TREX in a non-SAP environment.

BWA.TREX.Load Metrics This property contains the thresholds for system 
workload metrics.

BWA.TREX.Long Running Threads – Types 
to Exclude

This property contains the thread types that should not 
be monitored for long running threads.

BWA.TREX.Long Running Threads 
Thresholds

This property contains the thresholds for long running 
threads.

Thread types can be excluded from monitoring using 
the target property BWA.TREX.Long Running Threads 
– Types to Exclude.

BWA.TREX.Service Statistics Threshold This property contains the threshold values to be used 
for monitoring TREX Service Statistics in a non-SAP 
environment.
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Core Automation for SAP BW, BOBJ and In-Memory Computing Global 
Variables

The following table contains the global variables that are imported by the Core Automation for SAP BW, 
BOBJ and In-Memory Computing automation pack.

For instructions on configuring global variables, see the Cisco Process Orchestrator User Guide.

Core Automation for SAP BW, BOBJ and In-Memory Computing Target Groups
The Core Automation for SAP BW, BOBJ and In-Memory Computing automation pack provides the 
target groups that are used by the processes. Most of the target groups are automatically populated with 
members when the targets are configured. For those that are not automatically populated, you must 
manually add the members. 

The following table contains the target groups that are imported by the Core Automation for SAP BW, 
BOBJ and In-Memory Computing automation pack.

For information on adding members to target groups, see the Cisco Process Orchestrator User Guide.

Global Variable Name Description

BOBJ – Alert Suppression Time This global variable contains the duration that duplicate 
Cisco Process Orchestrator BOBJ alerts will be 
suppressed. After this time, a new alert and incident will 
be created.

Target Group Name Description

Automatically 
Populated with 
Members

Direct TREX Servers All Unix targets for TREX Servers.

Enter the list of Unix targets manually.

No
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Automation Pack Dependencies
Use the Dependencies tab on the automation pack Properties dialog box to view the automation packs 
and adapters referenced by the objects in the automation pack. These objects must be installed prior to 
importing the Core Automation for SAP BW, BOBJ and In-Memory Computing automation pack.

For instructions on accessing the automation pack properties, see Accessing Automation Pack 
Properties, page 2-1.

Core Automation for SAP BW, BOBJ and In-Memory Computing 
Activities

The following table contains the atomic processes (activities) that are imported by the Core Automation 
for SAP BW, BOBJ and In-Memory Computing automation pack.

Object Type Dependency

Automation Packs  • Core

Adapters  • Core Functions Adapter

 • Terminal Adapter

Process Name Description

BWA TREX – Cancel Running 
Reorganization

Stops the index reorganization process.

See BWA TREX—Cancel Running Reorganization 
Activity, page A-9.

BWA TREX – Continue Reorganization Continues a stopped index reorganization process.

See BWA TREX—Continue Reorganization Activity, 
page A-11.

BWA TREX – Delete All Indexes Deletes all indexes from the BWA instance.

See BWA TREX—Delete All Indexes Activity, 
page A-12.

BWA TREX – Delete Index Deletes a specific index from the BWA instance.

See BWA TREX—Delete Index Activity, page A-13.

BWA TREX – Execute Query Executes a TREX query against a specified index to 
return query response time.

See BWA TREX—Execute Query Activity, page A-13.

BWA TREX – Get Alert Details Displays current alert details.

See BWA TREX—Get Alert Details Activity, 
page A-15.

BWA TREX – Get Alerts Displays current alert summary.

See BWA TREX—Get Alerts Activity, page A-15.

BWA TREX – Get Index Usage Returns index usage and statistical data.

See BWA TREX—Get Index Usage Activity, 
page A-17.
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BWA TREX – Get Indexes Retrieves technical data for all indexes for a TREX 
system.

See BWA TREX—Get Indexes Activity, page A-17.

BWA TREX - Get Landscape Summary Retrieves a summary of the overall BWA landscape 
system health.

See BWA TREX—Get Landscape Summary Activity, 
page A-19.

BWA TREX – Get Last Reorganization Plan Displays details of the last index reorganization plan.

See BWA TREX—Get Last Reorganization Plan 
Activity, page A-19.

BWA TREX – Get Load Metrics Retrieves current TREX system workload metrics.

See BWA TREX—Get Load Metrics Activity, 
page A-21.

BWA TREX – Get Loaded Indexes Displays the indexes that are currently online in the 
BWA instance.

See BWA TREX—Get Loaded Indexes Activity, 
page A-21.

BWA TREX – Get Long Running Threads Retrieves a list of currently active long running TREX 
engine threads.

See BWA TREX—Get Long Running Threads Activity, 
page A-23.

BWA TREX – Get Next Reorganization Plan Displays details of the next index reorganization plan.

See BWA TREX—Get Next Reorganization Plan 
Activity, page A-23.

BWA TREX – Get Reorganization Summary Displays current state of index reorganization 
requirements and suggested plan.

See BWA TREX—Get Reorganization Summary 
Activity, page A-25.

BWA TREX - Get Service Statistics Retrieves current TREX engine service runtime 
statistics, such as CPU, memory and response time.

See BWA TREX—Get Service Statistics Activity, 
page A-26.

BWA TREX – Preload Index Preloads an index into the instance array memory.

See BWA TREX—Get Service Statistics Activity, 
page A-26.

BWA TREX – Restart Service Restarts individual TREX service processes.

See BWA TREX—Restart Service Activity, page A-27.

BWA TREX – Start Reorganization Starts the execution of the index reorganization.

See BWA TREX— Start Reorganization Activity, 
page A-29.

Process Name Description
A-5
Process Automation Guide for Automation for SAP BOBJ Accelerator

OL-30852-01



 

Appendix A      Core Automation for SAP BW, BOBJ and In-Memory Computing Automation Pack Content
  Core Automation for SAP BW, BOBJ and In-Memory Computing Activities
Defining an Activity
Use the following steps to define an activity in the Process Editor. The property pages that display 
depend on the activity. Refer to the appropriate section for instructions on completing the activity 
property pages.

Step 1 On the Toolbox pane, navigate to the appropriate section, click the activity and drag it onto the Workflow 
pane.

The Activity Properties dialog box displays.

Note The Required Value  icon displayed on a tab or page indicates that the field is required and 
is either missing a value or contains an invalid value. 
 
Click the Reference  tool to select a defined variable or reference an object within the 
process. For additional information, see the Cisco Process Orchestrator User Guide.

Step 2 On the General tab, enter the following information:

Step 3 Click the Activity-specific tab (typically, Inputs) and enter the required information. See the appropriate 
section in this chapter for instructions on completing the fields on the activity-specific tab.

Step 4 Click the Target tab to specify the process target. You can use the process target or override it and 
specify a different target for the specific activity.

BWA TREX – Test HTTP Status Checks the TREX http server status.

See BWA TREX—Test HTTP Status Activity, 
page A-29.

BWA TREX – Unload Index Unloads an index from the BWA instance.

See BWA TREX—Unload Index Activity, page A-31.

Process Name Description

Field Description

Name Name of the activity.

Type Display only. Displays the type of activity.

Description Text description of the activity.

Field Description

Execute on the process target Click this radio button to use the same target that was 
specified for the process.

Execute on activity target Click this radio button to indicate that the activity 
should execute against a target selected in an activity 
within the process. Choose the activity from the 
drop-down list.
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Step 5 Click the Credentials tab to specify the runtime user whose credentials should be used for process 
execution:

Execute on this target Click this radio button and then click the Browse  
tool to launch the Select Target dialog box and choose 
a specific target on which to execute the activity. 

The targets that display in the Select Target dialog box 
are targets already defined in Process Orchestrator. 

To view the properties for the selected target, click the 
Properties  tool. 

Execute on this target reference Click this radio button and then click the Reference  
tool to select the target reference property on which to 
execute the activity.

You can also click the click the Browse  tool to 
launch the Select Target dialog box and choose a 
specific target on which to execute the activity.

Execute on this target group Click this radio button and then click the Browse  
tool to launch the Select Target Group dialog box and 
choose a specific target on which to execute the 
activity. 

The target groups that display in the Select Target 
Group dialog box are target groups already defined in 
Process Orchestrator. 

To view the properties for the selected target group, 
click the Properties  tool. 

From the Choose a target using this algorithm 
drop-down list, select the algorithm which will 
determine the target to execute from the eligible target 
group.

Note The available algorithms that display depend on 
the selected activity. 

Field Description

Use target's default runtime user Click this radio button to use the default runtime user for 
the target that is specified in the activity.

Use process runtime user Click this radio button to use the credentials for the runtime 
user that was specified for the process.

Field Description
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Step 6 Click the Knowledge Base tab to specify a knowledge base article for the activity. The following 
information displays:

a. If the knowledge base article is not displayed by default, click the Browse  tool in the Knowledge 
Base field. 

b. On the Select Knowledge Base dialog box, select the appropriate knowledge base article in the list 
and click OK.

Note Click New to create a new knowledge base article. For additional information on knowledge base 
articles, see the Cisco Process Orchestrator User Guide.

Step 7 Click the Result Handlers tab to specify condition branches for the activity.

Step 8 Click the Save  tool to save the activity definition.

Override process runtime user Click this radio button to specify different credentials than 
what are used for the process. The selected runtime user 
overrides the runtime user that was specified for the 
process.

 • To view the properties for the selected runtime user, 
click the Properties  tool. 

 • To create a runtime user record for the process, click 
New. 

For additional information on creating a runtime users, see 
the Cisco Process Orchestrator User Guide.

Field Description

Knowledge base Knowledge base article associated with the activity.

Summary Brief description of the issue.

Possible Cause Explanation of the condition that may be causing the 
issue.

Possible resolution List of actions that can be performed to attempt to 
resolve the issue.

Related information Additional information related to the issue.

Field Description

Button Description

Add Adds a condition branch.

Remove Removes the condition branch from the activity.

Move Up Moves the condition up one position in the list of 
conditions.

Move Down Moves the condition down one position in the list of 
conditions.
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Viewing Activity Results
When an activity is executed, results are displayed in the Operations workspace activity instance view. 

Step 1 In the Operations workspace, expand the Activity Views folder and click the view that represents how 
the process was executed (for example, View Adhoc, if the process was manually executed). 

Step 2 In the View Results pane, expand the process, and double-click the activity instance or right-click and 
choose Observe.

Step 3 On the Process Viewer, ensure that Properties is enabled in the View menu, and then click the activity 
in the workflow to display the activity instance properties.

Step 4 If the activity required input values, click the Inputs tab to view the display-only properties of the 
activity.

Step 5 Click the Outputs tab to view the results of the activity.

Step 6 When you have completed viewing the properties, close the Process Viewer.

Defining the BWA TREX Activities
This section provides instructions for defining the BWA TREX activities.

BWA TREX—Cancel Running Reorganization Activity
Use the BWA TREX—Cancel Running Reorganization activity to stop an index reorganization process.

Step 1 On the Toolbox pane, click the BWA TREX—Cancel Running Reorganization activity and drag it 
onto the Workflow pane.

Step 2 On the General tab, enter the following information:

Step 3 Click the Inputs tab.

Step 4 In the Timeout (secs) text field, specify the number of seconds to allow for the SSH call to complete its 
operation on BWA.

Step 5 Complete the appropriate information in the following tabs:

 • Target—Specify whether the defined process target should be used or overridden.

 • Credentials—Specify the runtime user whose credentials should be used for process execution.

 • Knowledge Base—Select the appropriate knowledge base article to associate with the activity.

 • Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Field Description

Name Name of the activity.

Type Display only. Displays the type of activity.

Description Text description of the activity.
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Step 6 Click the Save  tool to save the activity definition.
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BWA TREX—Continue Reorganization Activity
Use the BWA TREX—Continue Reorganization activity to continue an index reorganization process that 
has been stopped.

Step 1 On the Toolbox pane, click the BWA TREX—Continue Reorganization activity and drag it onto the 
Workflow pane.

Step 2 On the General tab, enter the following information:

Step 3 Click the Inputs tab. 

Step 4 In the Timeout (secs) text field, specify the number of seconds to allow for the SSH call to complete its 
operation on BWA.

Step 5 Complete the appropriate information in the following tabs:

 • Target—Specify whether the defined process target should be used or overridden.

 • Credentials—Specify the runtime user whose credentials should be used for process execution.

 • Knowledge Base—Select the appropriate knowledge base article to associate with the activity.

 • Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6 Click the Save  tool to save the activity definition.

Field Description

Name Name of the activity.

Type Display only. Displays the type of activity.

Description Text description of the activity.
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BWA TREX—Delete All Indexes Activity
Use the BWA TREX—Delete All Indexes activity to delete all indexes from the BWA instance.

Step 1 On the Toolbox pane, click the BWA TREX—Delete All Indexes activity and drag it onto the Workflow 
pane.

Step 2 On the General tab, enter the following information:

Step 3 Complete the appropriate information in the following tabs:

 • Target—Specify whether the defined process target should be used or overridden.

 • Credentials—Specify the runtime user whose credentials should be used for process execution.

 • Knowledge Base—Select the appropriate knowledge base article to associate with the activity.

 • Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 4 Click the Save  tool to save the activity definition.

Field Description

Name Name of the activity.

Type Display only. Displays the type of activity.

Description Text description of the activity.
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BWA TREX—Delete Index Activity
Use the BWA TREX—Delete Index activity to delete a specific index from the BWA instance.

Step 1 On the Toolbox pane, click the BWA TREX—Delete Index activity and drag it onto the Workflow pane.

Step 2 On the General tab, enter the following information:

Step 3 Click the Inputs tab.

Step 4 On the Inputs tab, enter the following information:

Step 5 Complete the appropriate information in the following tabs:

 • Target—Specify whether the defined process target should be used or overridden.

 • Credentials—Specify the runtime user whose credentials should be used for process execution.

 • Knowledge Base—Select the appropriate knowledge base article to associate with the activity.

 • Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6 Click the Save  tool to save the activity definition.

BWA TREX—Execute Query Activity
Use the BWA TREX—Execute Query activity to execute a TREX query against a specific index. This 
activity returns the query response time.

Step 1 On the Toolbox pane, click the BWA TREX—Execute Query activity and drag it onto the Workflow 
pane.

Step 2 On the General tab, enter the following information:

Field Description

Name Name of the activity.

Type Display only. Displays the type of activity.

Description Text description of the activity.

Field Description

Index ID Index technical name for the index to be deleted.

Timeout (sec) Number of seconds to allow for the SSH call to complete 
its operation on BWA.

Field Description

Name Name of the activity.

Type Display only. Displays the type of activity.

Description Text description of the activity.
A-13
Process Automation Guide for Automation for SAP BOBJ Accelerator

OL-30852-01



 

Appendix A      Core Automation for SAP BW, BOBJ and In-Memory Computing Automation Pack Content
  Defining the BWA TREX Activities
Step 3 Click the Inputs tab. 

Step 4 On the Inputs tab, enter the following information:

Step 5 Complete the appropriate information in the following tabs:

 • Target—Specify whether the defined process target should be used or overridden.

 • Credentials—Specify the runtime user whose credentials should be used for process execution.

 • Knowledge Base—Select the appropriate knowledge base article to associate with the activity.

 • Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6 Click the Save  tool to save the activity definition.

Field Description

Options Options to designate the TREX query and index to be 
executed.

Timeout (sec) Number of seconds to allow for the SSH call to 
complete its operation on BWA.
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BWA TREX—Get Alert Details Activity
Use the BWA TREX—Get Alert Details activity to retrieve current alert details.

Step 1 On the Toolbox pane, click the BWA TREX—Get Alert Details activity and drag it onto the Workflow 
pane.

Step 2 On the General tab, enter the following information:

Step 3 Click the Inputs tab. 

Step 4 In the Timeout (secs) text field, specify the number of seconds to allow for the SSH call to complete its 
operation on BWA.

Step 5 Complete the appropriate information in the following tabs:

 • Target—Specify whether the defined process target should be used or overridden.

 • Credentials—Specify the runtime user whose credentials should be used for process execution.

 • Knowledge Base—Select the appropriate knowledge base article to associate with the activity.

 • Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6 Click the Save  tool to save the activity definition.

BWA TREX—Get Alerts Activity
Use the BWA TREX—Get Alerts activity to retrieve a list of alerts.

Step 1 On the Toolbox pane, click the BWA TREX—Get Alerts activity and drag it onto the Workflow pane.

Step 2 On the General tab, enter the following information:

Step 3 Click the Inputs tab. 

Field Description

Name Name of the activity.

Type Display only. Displays the type of activity.

Description Text description of the activity.

Field Description

Name Name of the activity.

Type Display only. Displays the type of activity.

Description Text description of the activity.
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Step 4 On the Inputs tab, enter the following information:

Step 5 Complete the appropriate information in the following tabs:

 • Target—Specify whether the defined process target should be used or overridden.

 • Credentials—Specify the runtime user whose credentials should be used for process execution.

 • Knowledge Base—Select the appropriate knowledge base article to associate with the activity.

 • Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6 Click the Save  tool to save the activity definition.

Field Description

Age (minutes) Retrieve alerts that have occured within the last X minutes 
indicated in this field.

Severity Severity level of alerts to be retrieved (Red, Yellow, Green, 
Grey, All).

Timeout (sec) Number of seconds to allow for the SSH call to complete 
its operation on BWA.
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BWA TREX—Get Index Usage Activity
Use the BWA TREX—Get Index Usage activity to return index usage and statistical data.

Step 1 On the Toolbox pane, click the BWA TREX—Get Index Usage activity and drag it onto the Workflow 
pane.

Step 2 On the General tab, enter the following information:

Step 3 Click the Inputs tab. 

Step 4 Specify the following information:

Step 5 Complete the appropriate information in the following tabs:

 • Target—Specify whether the defined process target should be used or overridden.

 • Credentials—Specify the runtime user whose credentials should be used for process execution.

 • Knowledge Base—Select the appropriate knowledge base article to associate with the activity.

 • Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6 Click the Save  tool to save the activity definition.

BWA TREX—Get Indexes Activity
Use the BWA TREX—Get Indexes activity to retrieve a list of the loaded indexes.

Step 1 On the Toolbox pane, click the BWA TREX—Get Indexes activity and drag it onto the Workflow pane.

Field Description

Name Name of the activity.

Type Display only. Displays the type of activity.

Description Text description of the activity.

Field Name Description

Start Date Date from which to begin collecting index usage data.

Start Time Time from which to begin collecting for the index usage 
data.

Index Name(s) Complete index name of the index or enter * to retreive 
usage data from all indexes.

Timeout (secs) Number of seconds to allow for the SSH call to 
complete its operation on BWA.
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Step 2 On the General tab, enter the following information:

Step 3 Click the Inputs tab. 

Step 4 Specify the following information:

Step 5 Complete the appropriate information in the following tabs:

 • Target—Specify whether the defined process target should be used or overridden.

 • Credentials—Specify the runtime user whose credentials should be used for process execution.

 • Knowledge Base—Select the appropriate knowledge base article to associate with the activity.

 • Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6 Click the Save  tool to save the activity definition.

Field Description

Name Name of the activity.

Type Display only. Displays the type of activity.

Description Text description of the activity.

Field Name Description

Index Name Complete name of the index or enter * to retrieve all 
indexes.

Timeout (secs) Number of seconds to allow for the SSH call to 
complete its operation on BWA.
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BWA TREX—Get Landscape Summary Activity
Use the BWA TREX—Get Landscape Summary activity to retrieve a summary of the overall BWA 
landscape system health.

Step 1 On the Toolbox pane, click the BWA TREX—Get Landscape Summary activity and drag it onto the 
Workflow pane.

Step 2 On the General tab, enter the following information:

Step 3 Click the Inputs tab. 

Step 4 In the Timeout (secs) text field, enter the number of seconds to allow for the SSH call to complete its 
operation on BWA.

Step 5 Complete the appropriate information in the following tabs:

 • Target—Specify whether the defined process target should be used or overridden.

 • Credentials—Specify the runtime user whose credentials should be used for process execution.

 • Knowledge Base—Select the appropriate knowledge base article to associate with the activity.

 • Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6 Click the Save  tool to save the activity definition.

BWA TREX—Get Last Reorganization Plan Activity
Use the BWA TREX—Get Last Reorganization Plan activity to retrieve the current state of index 
reorganization requirements and suggested plan.

Step 1 On the Toolbox pane, click the BWA TREX—Get Last Reorganization Plan activity and drag it onto 
the Workflow pane.

Step 2 On the General tab, enter the following information:

Step 3 Click the Inputs tab. 

Step 4 In the Timeout (secs) text field, enter the number of seconds to allow for the SSH call to complete its 
operation on BWA.

Field Description

Name Name of the activity.

Type Display only. Displays the type of activity.

Description Text description of the activity.

Field Description

Name Name of the activity.

Type Display only. Displays the type of activity.

Description Text description of the activity.
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Step 5 Complete the appropriate information in the following tabs:

 • Target—Specify whether the defined process target should be used or overridden.

 • Credentials—Specify the runtime user whose credentials should be used for process execution.

 • Knowledge Base—Select the appropriate knowledge base article to associate with the activity.

 • Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6 Click the Save  tool to save the activity definition.
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BWA TREX—Get Load Metrics Activity
Use the BWA TREX—Get Load Metrics activity to retrieve current TREX system workload metrics.

Step 1 On the Toolbox pane, click the BWA TREX—Get Load Metrics activity and drag it onto the Workflow 
pane.

Step 2 On the General tab, enter the following information:

Step 3 Click the Inputs tab. 

Step 4 Specify the following information:

Step 5 Complete the appropriate information in the following tabs:

 • Target—Specify whether the defined process target should be used or overridden.

 • Credentials—Specify the runtime user whose credentials should be used for process execution.

 • Knowledge Base—Select the appropriate knowledge base article to associate with the activity.

 • Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6 Click the Save  tool to save the activity definition.

BWA TREX—Get Loaded Indexes Activity
Use the BWA TREX—Get Loaded Indexes activity to retrieve the indexes that are currently online in the 
BWA instance.

Step 1 On the Toolbox pane, click the BWA TREX—Get Loaded Indexes activity and drag it onto the 
Workflow pane.

Field Description

Name Name of the activity.

Type Display only. Displays the type of activity.

Description Text description of the activity.

Field Name Description

Host TREX host name to return metrics.

Minutes Retrieve metrics within the past X minutes specified in this 
field.

Metric Names Comma separated list of metric names to return.

Timeout (secs) Number of seconds to allow for the SSH call to complete 
its operation on BWA.
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Step 2 On the General tab, enter the following information:

Step 3 Click the Inputs tab. 

Step 4 In the Timeout (secs) text field, enter the number of seconds to allow for the SSH call to complete its 
operation on BWA.

Step 5 Complete the appropriate information in the following tabs:

 • Target—Specify whether the defined process target should be used or overridden.

 • Credentials—Specify the runtime user whose credentials should be used for process execution.

 • Knowledge Base—Select the appropriate knowledge base article to associate with the activity.

 • Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6 Click the Save  tool to save the activity definition.

Field Description

Name Name of the activity.

Type Display only. Displays the type of activity.

Description Text description of the activity.
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BWA TREX—Get Long Running Threads Activity
Use the BWA TREX—Get Long Running Threads activity to retrieve a list of currently active long 
running TREX engine threads.

Step 1 On the Toolbox pane, click the BWA TREX—Get Long Running Threads activity and drag it onto the 
Workflow pane.

Step 2 On the General tab, enter the following information:

Step 3 Click the Inputs tab. 

Step 4 Specify the following information:

Step 5 Complete the appropriate information in the following tabs:

 • Target—Specify whether the defined process target should be used or overridden.

 • Credentials—Specify the runtime user whose credentials should be used for process execution.

 • Knowledge Base—Select the appropriate knowledge base article to associate with the activity.

 • Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6 Click the Save  tool to save the activity definition.

BWA TREX—Get Next Reorganization Plan Activity
Use the BWA TREX—Get Next Reorganization Plan activity to retrieve details of the next index 
reorganization plan.

Step 1 On the Toolbox pane, click the BWA TREX—Get Next Reorganization Plan activity and drag it onto 
the Workflow pane.

Field Description

Name Name of the activity.

Type Display only. Displays the type of activity.

Description Text description of the activity.

Field Name Description

Warning Threshold Enter the value for the amount of time before a thread 
reaches the Warning threshold (default is “5sec”).

Error Threshold Enter the value for the amount of time before a thread 
reaches the Error threshold (default is “10sec”).

Timeout (secs) Number of seconds to allow for the SSH call to 
complete its operation on BWA.
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Step 2 On the General tab, enter the following information:

Step 3 Click the Inputs tab. 

Step 4 In the Timeout (secs) text field, enter the number of seconds to allow for the SSH call to complete its 
operation on BWA.

Step 5 Complete the appropriate information in the following tabs:

 • Target—Specify whether the defined process target should be used or overridden.

 • Credentials—Specify the runtime user whose credentials should be used for process execution.

 • Knowledge Base—Select the appropriate knowledge base article to associate with the activity.

 • Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6 Click the Save  tool to save the activity definition.

Field Description

Name Name of the activity.

Type Display only. Displays the type of activity.

Description Text description of the activity.
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BWA TREX—Get Reorganization Summary Activity
Use the BWA TREX—Get Reorganization Summary activity to retrieve current state of index 
reorganization requirements and suggested plan.

Step 1 On the Toolbox pane, click the BWA TREX—Get Reorganization Summary activity and drag it onto 
the Workflow pane.

Step 2 On the General tab, enter the following information:

Step 3 Click the Inputs tab. 

Step 4 In the Timeout (secs) text field, enter the number of seconds to allow for the SSH call to complete its 
operation on BWA.

Step 5 Complete the appropriate information in the following tabs:

 • Target—Specify whether the defined process target should be used or overridden.

 • Credentials—Specify the runtime user whose credentials should be used for process execution.

 • Knowledge Base—Select the appropriate knowledge base article to associate with the activity.

 • Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6 Click the Save  tool to save the activity definition.

Field Description

Name Name of the activity.

Type Display only. Displays the type of activity.

Description Text description of the activity.
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BWA TREX—Get Service Statistics Activity
Use the BWA TREX—Get Service Statistics activity to retrieve current TREX engine service runtime 
statistics, such as CPU, memory and response time.

Step 1 On the Toolbox pane, click the BWA TREX—Get Service Statistics activity and drag it onto the 
Workflow pane.

Step 2 On the General tab, enter the following information:

Step 3 Click the Inputs tab. 

Step 4 In the Timeout (secs) text field, enter the number of seconds to allow for the SSH call to complete its 
operation on BWA.

Step 5 Complete the appropriate information in the following tabs:

 • Target—Specify whether the defined process target should be used or overridden.

 • Credentials—Specify the runtime user whose credentials should be used for process execution.

 • Knowledge Base—Select the appropriate knowledge base article to associate with the activity.

 • Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6 Click the Save  tool to save the activity definition.

Field Description

Name Name of the activity.

Type Display only. Displays the type of activity.

Description Text description of the activity.
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BWA TREX—Preload Index Activity
Use the BWA TREX—Preload Index activity to preload an index into the instance array memory.

Step 1 On the Toolbox pane, click the BWA TREX—Preload Index activity and drag it onto the Workflow 
pane.

Step 2 On the General tab, enter the following information:

Step 3 Click the Inputs tab. 

Step 4 Specify the following information:

Step 5 Complete the appropriate information in the following tabs:

 • Target—Specify whether the defined process target should be used or overridden.

 • Credentials—Specify the runtime user whose credentials should be used for process execution.

 • Knowledge Base—Select the appropriate knowledge base article to associate with the activity.

 • Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6 Click the Save  tool to save the activity definition.

BWA TREX—Restart Service Activity
Use the BWA TREX—Restart Service activity to restart individual TREX service processes.

Step 1 On the Toolbox pane, click the BWA TREX—Restart Service activity and drag it onto the Workflow 
pane.

Step 2 On the General tab, enter the following information:

Field Description

Name Name of the activity.

Type Display only. Displays the type of activity.

Description Text description of the activity.

Field Name Description

Index ID Index technical name for the index.

Timeout (secs) Number of seconds to allow for the SSH call to complete 
its operation on BWA.

Field Description

Name Name of the activity.

Type Display only. Displays the type of activity.

Description Text description of the activity.
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Step 3 Click the Inputs tab. 

Step 4 Specify the following information:

Step 5 Complete the appropriate information in the following tabs:

 • Target—Specify whether the defined process target should be used or overridden.

 • Credentials—Specify the runtime user whose credentials should be used for process execution.

 • Knowledge Base—Select the appropriate knowledge base article to associate with the activity.

 • Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6 Click the Save  tool to save the activity definition.

Field Name Description

Service TREX service to restart (Index Server, Name Server, 
etc.).

Host Blade host name.

Port TREX service port.

Timeout (secs) Number of seconds to allow for the SSH call to 
complete its operation on BWA.
A-28
Process Automation Guide for Automation for SAP BOBJ Accelerator

OL-30852-01



 

Appendix A      Core Automation for SAP BW, BOBJ and In-Memory Computing Automation Pack Content
  Defining the BWA TREX Activities
BWA TREX— Start Reorganization Activity
Use the BWA TREX—Start Reorganization activity to start the execution of the index reorganization.

Step 1 On the Toolbox pane, click the BWA TREX—Start Reorganization Plan activity and drag it onto the 
Workflow pane.

Step 2 On the General tab, enter the following information:

Step 3 Click the Inputs tab. 

Step 4 In the Timeout (secs) text field, enter the number of seconds to allow for the SSH call to complete its 
operation on BWA.

Step 5 Complete the appropriate information in the following tabs:

 • Target—Specify whether the defined process target should be used or overridden.

 • Credentials—Specify the runtime user whose credentials should be used for process execution.

 • Knowledge Base—Select the appropriate knowledge base article to associate with the activity.

 • Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6 Click the Save  tool to save the activity definition.

BWA TREX—Test HTTP Status Activity
Use the BWA TREX—Test HTTP Status activity to check the status of the TREX http server.

Step 1 On the Toolbox pane, click the BWA TREX—Test HTTP Status activity and drag it onto the Workflow 
pane.

Step 2 On the General tab, enter the following information:

Step 3 Click the Inputs tab. 

Step 4 In the Timeout (secs) text field, enter the number of seconds to allow for the SSH call to complete its 
operation on BWA.

Step 5 Complete the appropriate information in the following tabs:

 • Target—Specify whether the defined process target should be used or overridden.

Field Description

Name Name of the activity.

Type Display only. Displays the type of activity.

Description Text description of the activity.

Field Description

Name Name of the activity.

Type Display only. Displays the type of activity.

Description Text description of the activity.
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 • Credentials—Specify the runtime user whose credentials should be used for process execution.

 • Knowledge Base—Select the appropriate knowledge base article to associate with the activity.

 • Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6 Click the Save  tool to save the activity definition.
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BWA TREX—Unload Index Activity
Use the BWA TREX—Unload Index activity to unload an index from the BWA instance.

Step 1 On the Toolbox pane, click the BWA TREX—Unload Index activity and drag it onto the Workflow 
pane.

Step 2 On the General tab, enter the following information:

Step 3 Click the Inputs tab. 

Step 4 Specify the following information:

Step 5 Complete the appropriate information in the following tabs:

 • Target—Specify whether the defined process target should be used or overridden.

 • Credentials—Specify the runtime user whose credentials should be used for process execution.

 • Knowledge Base—Select the appropriate knowledge base article to associate with the activity.

 • Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6 Click the Save  tool to save the activity definition.

Field Description

Name Name of the activity.

Type Display only. Displays the type of activity.

Description Text description of the activity.

Field Name Description

Index ID Index technical name for the index.

Timeout (secs) Number of seconds to allow for the SSH call to complete 
its operation on BWA.
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 P P E N D I X B

Understanding the Common Activities Content

The Intelligent Automation for SAP Automation Pack for Common Activities contains content that is 
used in the other automation packs. 

This appendix contains the content included in the Common Activities automation pack. It contains the 
following sections:

 • Automation Pack Content, page B-1

 • Defining the Common Activities, page B-2

Automation Pack Content 
Use the automation pack Properties dialog box to view the content (objects) included in the automation 
pack. For instructions on accessing the automation pack properties, see Accessing Automation Pack 
Properties, page 2-1.

The Common Activities automation pack provides additional activities (atomic processes) that can be 
used in other automation packs. These are additional activities display in the Process Editor toolbox after 
the user has imported the automation packs.

The following table displays the activities that are provided by the Common Activities automation pack.

Note To launch these activities, the runtime user should have local administrative rights to the target. If the 
runtime user does not have these rights, the activity will fail and display a message that the process has 
encountered a failed node.

Activity Description

Convert Integer to IP Address Changes an integer to an IP address.

See Defining the Convert Integer to IP Address 
Activity, page B-2.

Convert IP Address to Integer Changes an IP address to an integer.

See Defining the Convert IP Address to Integer 
Activity, page B-4.
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Defining the Common Activities
This section provides instructions for defining the activities included in the Common Activities 
automation pack.

Defining the Convert Integer to IP Address Activity
Use the Convert Integer to IP Address activity to find change an integer to an IP address.

Step 1 On the Toolbox pane, click the Convert Integer to IP Address activity and drag it onto the Workflow 
pane.

Ping Specifies the name or IP address of the server to be 
pinged. 

See Defining the Ping Activity, page B-4.

Stop a Unix Process (via SSH) Stops a running Unix process through SSH.

See Defining the Stop a Unix Process Activity, 
page B-6.

Stop a Windows Process Stops a running Windows process.

See Defining the Stop a Windows Process Activity, 
page B-7.

Activity Description
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Step 2 On the General tab, enter the following information:

Step 3 Click the Inputs tab. 

Step 4 In the Integer Representation text field, specify the integer value to be returned as an IP address.

For example, entering:

 • 0 returns an IP address of 0.0.0.0

 • 3232271626 returns and IP address of 192.168.141.10

Step 5 Complete the appropriate information in the following tabs:

 • Target—Specify whether the defined process target should be used or overridden.

 • Credentials—Specify the runtime user whose credentials should be used for process execution.

 • Knowledge Base—Select the appropriate knowledge base article to associate with the activity.

 • Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6 Click the Save  tool to save the activity definition.

Field Description

Name Name of the activity.

Type Display only. Displays the type of activity.

Description Text description of the activity.
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Defining the Convert IP Address to Integer Activity
Use the Convert IP Address to Integer activity to find change an IP address to an integer.

Step 1 On the Toolbox pane, click the Convert IP Address to Integer activity and drag it onto the Workflow 
pane.

Step 2 On the General tab, enter the following information:

Step 3 Click the Inputs tab. 

Step 4 In the IP Address text field, specify the IP address to be returned as an integer.

Step 5 Complete the appropriate information in the following tabs:

 • Target—Specify whether the defined process target should be used or overridden.

 • Credentials—Specify the runtime user whose credentials should be used for process execution.

 • Knowledge Base—Select the appropriate knowledge base article to associate with the activity.

 • Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6 Click the Save  tool to save the activity definition.

Defining the Ping Activity
Use the Ping activity to ping a server during network troubleshooting.

Step 1 On the Toolbox pane, click the Ping activity and drag it onto the Workflow pane.

Step 2 On the General tab, enter the following information:

Step 3 Click the Inputs tab.

Step 4 In the Destination text field, specify the host name or IP address of the server to be pinged.

Step 5 Complete the appropriate information in the following tabs:

 • Target—Specify whether the defined process target should be used or overridden.

 • Credentials—Specify the runtime user whose credentials should be used for process execution.

 • Knowledge Base—Select the appropriate knowledge base article to associate with the activity.

Field Description

Name Name of the activity.

Type Display only. Displays the type of activity.

Description Text description of the activity.

Field Description

Name Name of the activity.

Type Display only. Displays the type of activity.

Description Text description of the activity.
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 • Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6 Click the Save  tool to save the activity definition.
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Defining the Stop a Unix Process Activity
Use the Stop a Unix Process (via SSH) activity to stop a running Unix process.

Step 1 On the Toolbox pane, click the Stop a Unix Process (via SSH) activity and drag it onto the Workflow 
pane.

Step 2 On the General tab, enter the following information:

Step 3 Click the Inputs tab. 

Step 4 In the PID field, enter the ID for the process that you want to stop.

Step 5 Complete the appropriate information in the following tabs:

 • Target—Specify whether the defined process target should be used or overridden.

 • Credentials—Specify the runtime user whose credentials should be used for process execution.

 • Knowledge Base—Select the appropriate knowledge base article to associate with the activity.

 • Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6 Click the Save  tool to save the activity definition.

Field Description

Name Name of the activity.

Type Display only. Displays the type of activity.

Description Text description of the activity.
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Defining the Stop a Windows Process Activity
Use the Stop a Windows Process activity to stop a running Windows process.

Step 1 On the Toolbox pane, click the Stop a Windows activity and drag it onto the Workflow pane.

Step 2 On the General tab, enter the following information:

Step 3 Click the Inputs tab. 

Step 4 In the PID field, enter the ID for the process that you want to stop.

Step 5 Complete the appropriate information in the following tabs:

 • Target—Specify whether the defined process target should be used or overridden.

 • Credentials—Specify the runtime user whose credentials should be used for process execution.

 • Knowledge Base—Select the appropriate knowledge base article to associate with the activity.

 • Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6 Click the Save  tool to save the activity definition.

Field Description

Name Name of the activity.

Type Display only. Displays the type of activity.

Description Text description of the activity.
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